
ICT Progression Nursery - P7        P7 
 Strands/ Learning Outcomes 
The children will be able to… 

Activities Resources 
(Common Network Resources) 

Teacher Comments / 
Assessment Notes 

USING THE TECHNOLOGY 
 
See the ‘Using the Technology’ P7 
sheet for further details 
 

 
 
 
 

List of computer terminology  

CREATING AND PRESENTING 
Graphic Manipulation 
5-14 D “Using a range of drawing/painting 
facilities, extend graphic manipulation skills” 
 
Using Colour Magic, explore the 
menu options, eg Image menu – 
Colour Effects, Image Filters. Options 
menu – Snap To Grid, Grid Settings 
 
 
 
 
Add special effects to alter the 
appearance of a graphic 
 
 
 
Save a Colour Magic image as a gif or 
jpg, where possible, showing 
awareness of file size 
 
Appreciate the importance of file size 
and use Image > Resize (Colour 
Magic) to reduce this 
 
Using MS Word, Publisher and 
PowerPoint, create documents 
showing confident use of: 

• inserting/pasting graphics 

Where practical, pupils should be 
encouraged to design their own 
illustrations in preference to 
constant use of clipart 
 
Explore the different effects possible 
in Colour Magic. Relate to Topic and 
Maths eg enterprise logos 
 
 
 
 
 
In Colour Magic, open (File menu) a 
previously saved digital camera 
photo, or other graphic, and add 
Colour Effects or Image Filters 
 
If pupils have been using some of the 
image effects and filters, it is not 
always possible to save them as .jpgs 
in Colour Magic. Therefore pupils 
must use Image > Resize before 
copying or saving the graphic 
 
For example: 
- Annotated labelled diagrams of 
European countries or the digestive 
tract 
- World War II illustrated timeline  

 
 
 
 
 
Suitable exercises exploring the 
menus in Colour Magic: 
[W] http://www.educationict.org.uk/ 
pdf/colmaghein6.pdf 
 
[W] http://www.educationict.org.uk/ 
pdf/colmaglevcduppprimary.pdf 
 
Adding special effects to images is 
also possible with the QX3 Computer 
Microscope 
 
 
[CTB] Help Sheet – ‘How To Make 
Files Smaller’ file in the Colour Magic 
folder of the Curriculum Topic Bank in 
the School Shared Area 
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CREATING AND PRESENTING 
Text Handling 
5-14 D/E “Using appropriate software, extend 
WP skills by using more sophisticated text-
handling features…” 
 
Know when and why to choose 
particular WP/DTP programs 
 
Create and edit documents by: 

• selecting appropriate Page 
Setup option 

• confidently using text-
formatting tools, including ‘Fill’ 
and ‘Fill Effects’ 

• incorporating a range of 
graphics, if appropriate 

• using spell check, grammar 
check and synonym tools 

 
Use the ‘Highlight’ tool 
 
 
Use the ‘Word Count’ tool (Tools 
menu) 
 
 
Use the ‘Bullets’ and ‘Numbering’ 
tools 
 
 
Use the ‘Hanging Indent’ to indent 
blocks of text (as in a drama script) 
 
 
 

 
 
 
 
 
See Graphic Manipulation section 
above for other examples of 
documents combining text and 
graphics 
 
For example: poster, information 
sheet, report, advert, poem, brochure, 
letter, instructions, notice, book cover, 
label, postcard, bookmark 
 
Use text formatting to support 
language activities 
 
 
For example: 

• Highlight a topic sentence in a 
piece of writing 

 
• Teacher sets a writing task 

which demands a certain 
number of words 

 
• Bullet points or numbering for 

functional writing or 
structuring a piece of writing 

 
• Use of hanging indent to write 

short drama scripts or to 
support teaching of direct 
speech  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
[CTB] ‘How To Make a Hanging 
Indent’ file in the ‘Using MS Word’ 
folder in the Curriculum Topic Bank 
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CREATING AND PRESENTING 
Multimedia 
5-14 D/E “Create a presentation or web pages, 
using more sophisticated software, 
incorporating text, graphics, sound” 
Using PowerPoint, plan and create a 
presentation incorporating text, 
graphics from a variety of sources, 
WordArt, background, arrows, 
autoshapes, animation, sound 
 
Learn the difference between linear 
and non-linear (hyperlinked) 
presentations 
 
Plan and create a simple non-linear 
(hyperlinked) presentation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add short video clips to presentations 
(if facilities exist in the school) 

 
 
 
 
 
Revise a simple linear presentation to 
recap on skills – topic or interest 
based 
 
 
 
View the ‘Planning a Hyperlinked 
Presentation’ show. Teacher shows 
demo files. 
 
For example: 
Present a product for a Mini-
Enterprise topic. Home slide could 
have links to other slides on 
Production, Manufacturing Process, 
Personnel, Costing, Sales, etc 
 
Note 1: Do not try to put Custom 
Animation onto a hyperlinked 
presentation 
Note 2: In order for a hyperlinked 
presentation to work properly, 
uncheck the ‘Advance on Mouse 
Click’ option in the Slide Transition’ 
window (in the Slideshow menu) 
 
Pupils save video files into their My 
Work folders from floppy, microscope 
software or Internet (Internet files 
must be mpg video files for

 
 
 
 
 
 
 
 
 
 
[CTB] ‘PptShow Planning 
Hyperlinked’ file in the ‘PowerPoint’ 
folder in the Curriculum Topic Bank 
 
[CTB] ‘NonLin+notes’ file in the 
‘PowerPoint’ folder in the Curriculum 
Topic Bank 
 
The following are examples of non-
linear (or hyperlinked) presentations 
[CTB] ‘Ppt Demo The Body’ file in the 
‘Health’ folder and ‘Ppt Endangered 
Spec’ file in the Animals folder in the 
Curriculum Topic Bank 
 
 
Web authoring and hyperlinks in Word 
are other ways of approaching the 
idea of presenting information in a 
non-linear way 
 
 
Some Sony Mavica models are 
capable of taking short movies 
(approx 10 seconds) 
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COLLECTING AND ANALYSING 
Spreadsheet 
5-14 D “Set up a simple spreadsheet. Create 
suitable charts from the spreadsheet data” 
 
Use terms: rows, columns, cells, 
formula, sum, total, maximum, 
minimum, average, graph more 
than one data set 
 
Set up a spreadsheet including labels, 
data and formulae (sum, + add, - 
subtract, *multiply. /divide) 
 
Select appropriate graph/chart type 
 
Format graphs/charts to include titles, 
axis labels, colour, legend (key) for 
pie chart 
 
Copy and paste graphs/charts to WP / 
DTP programs and interpret the 
output in a short report 
 
 
Use selected ready-made 
spreadsheets 

 
Use RM Number Magic Blue Level  
 
 
 
 
Use progressive set of activities 
outlined in the booklet: 
 
 
‘An Introduction to Using 
Spreadsheets with RM Number 
Magic’, Part 3, Level D activities 16-
20 
 
 
This reinforces Maths activities at this 
level 
 
 
See Graphic Manipulation section 
above 
 
 
Open the ‘Exercises’ file within 
Number Magic to access ready-made 
spreadsheets 

 
At Red Level, decimal Number 
Functions are too complex. There is 
also no access to the ready-made 
Exercises files 
 
 
Publication from MEC, circulated to all 
schools, September 2002 and in 
[CTB] Number Magic folder in the 
Curriculum Topic Bank 
 
Other resources: 
[CTB] ‘Worksheet Enterprise 
Birthday/Xmas Cards’ file in Number 
Magic folder in the Curriculum Topic 
Bank 
 
[CTB] ‘Worksheet WWII Evacuation 
Statistics’ file in Number Magic folder 
in the Curriculum Topic Bank 
 
 
 
List of ready-made activities suitable 
for this level can be found in above 
booklet 

 

COLLECTING AND ANALYSING 
Database 
5-14 D “Use the basic structure of a database, 
different field types…Define fields…Search and 
sort databases…Produce reports” 
 
Use the terms record, field, 
fieldnames, navigation arrows, 

t h li t b fi ld

 
 
 
Use simple Information Magic (Blue or 
Red Level) ready-made datafiles on 
topic such as Survey, Birds, World 
Rivers, Planets, Minibeasts, Sweens. 
(Find these files by using the grey

An overview of Collecting and 
Analysing, Levels A-E is at: 
[W] http://www.educationict.org.uk 
/pdf/coll&analyseabcde.pdf 
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SEARCHING AND RESEARCHING 
5-14 D “Use keywords…Use a search 
engine…Use bookmarks (favourites)…Save 
text and graphics…Compare websites” 
 
Confidently go to selected websites, 
navigate, find information, copy 
graphics and text and show 
awareness of copyright issues 
 
 
Use Google Images search as a quick 
tool for finding images 
 
 
 
 
 
 
 
 
Before searching, state clearly what it 
is they are trying to find out and list 
possible keywords for a search 
 
 
Use search engines and search 
facilities within sites. Use keywords 
and refine the search if necessary 
 
 
 
Find suitable sites from search engine 
results, redirecting the search if 
necessary 
 

 
 
 
 
 
Support topic-based research and 
Creating and Presenting work 
 
Create a research ‘scrapbook’ in 
Word, collecting graphics and text as 
background information for use in a 
document or presentation. Pupils 
must be made aware of copyright and 
plagiarism. Text copied from the 
Internet should be used for research 
purposes only. If it is put into a pupil’s 
document or presentation, it should 
be fully credited as someone else’s 
work 
 
Discuss and plan, as a class, group or 
individual 
 
 
 
Use quotes to search for an exact 
phrase, + to add a second keyword, - 
(minus) to remove a word that you 
don’t want, eg WWII -US will remove 
some of the many references to the 
USA presence in the war. 
 
Use higher order skills such as 
skimming, looking for clues in the 
descriptors and website addresses, 

 
 
 
 
Visit pupil-oriented websites that are 
appropriate to different topic themes 
[W] 
http://www.educationict.org.uk/bpt/ 
OR 
[CTB] Use any of the ‘Websites’ Word 
files from the Curriculum Topic Bank 
in the School Shared Area. A list of all 
the ‘Websites’ Word files in the CTB 
can be found in the ‘ReadMe First’ 
Word document in the CTB folder. 
 
 
 
 
 
[CTB] ‘PlanSheet’ and ‘Factbank’ and 
‘PptShow S&R Level D’ from the 
Searching & Researching folder in the 
Curriculum Topic Bank in the School 
Shared Area 
 
Online searching tutorial at: 
[W] www.welcometotheweb.org.uk 
 
 
 
 
These are complex skills and teacher 
input and direction may still be 
necessary for many pupils 

 

Melrose Education Centre ICT Resources                                     PRIMARY 7 SECTION 11 

http://www.educationict.org.uk/bpt/
http://www.welcometotheweb.org.uk/


ICT Progression Nursery - P7        P7 
 Strands/ Learning Outcomes 
The children will be able to… 

Activities Resources 
(Common Network Resources) 

Teacher Comments / 
Assessment Notes 

Melrose Education Centre ICT Resources                                     PRIMARY 7 SECTION 12 



ICT Progression Nursery - P7        P7 
 Strands/ Learning Outcomes 
The children will be able to… 

Activities Resources 
(Common Network Resources) 

Teacher Comments / 
Assessment Notes 

COMMUNICATING AND 
COLLABORATING 
5-14 D/E “Send a copy of a message...Attach a 
previously prepared file” 
 
 
 
Participate in sending a class email 
and receiving attachments 
 
 
 
 
Send and reply to messages with an 
email partner (or email partner group) 
within the class 
 
Send and receive attachments 
 
 
 
Add addresses/contacts, if available 
 
 
 
 
Send emails outwith school (if 
appropriate) 

Continued opportunities to reinforce 
emailing skills, which include entering 
an address, entering message 
‘subject’ and message, replying to an 
email 
 
Send class emails – thank you 
messages, enquiries, invitations and 
requests for information. If required, 
teacher sends an attachment to the 
class email address, for pupils to 
open  
 
Email ‘with a purpose’, eg partners (or 
small groups) swap messages. 
For example: 
Mini-enterprise – email attachment of 
publicity flier from your company 
Design birthday message and email 
as an attachment to a friend 
 
Pupils will find emailing easier and 
faster if they have a functioning 
address book 
 
 
Corresponding with other classes and 
schools can be very rewarding, 
provided that a clear purpose is set 
beforehand 
For example: 
Country beyond Europe – teacher 
sets up contact with other school to 
exchange information 

For activities at this level, a class 
email address for contacting persons 
outwith the school is recommended 
 
 
 
‘Ask an expert’ email contacts from 
web sites, eg the ‘Ticket to Space’ 
online activity 
 
 
 
 
Make this a collaborative activity 
between groups if a computer suite is 
not available 
An imaginative approach like this 
lends itself to many topic themes 
 
 
 
Schools can elect to have this facility 
available to pupils as part of the 
network optimisation procedure 
(Aug/Sept 2003) 
 
Reinforcement of personal safety 
message – sending emails outwith the 
school could still be done using the 
class email address rather than 
individual addresses 

 

CONTROLLING AND MODELLING    
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CONTROLLING AND MODELLING 
5-14 D “Use…repeat/loop commands to make a 
basic pattern on screen…” 

 
Use all basic on-screen Roamer 
World commands, including repeat 
and pen up/pen down 
 
Use selected Roamer Journeys and 
Routes Activities  
 
 
 
 
 
 
 
Introduce ‘Procedures’, using either 
Floor Roamer or On-screen Roamer 

 
 
 
 
 
These are activity ‘challenges’ for 
pupils, with ready-made backgrounds. 
Pupils program Roamer to visit 
different items on the background, eg  
Cave Roamer, Subway, Tortoise and 
Hare (all in Routes). 
Teachers may wish to use the 
backgrounds in different ways, without 
committing themselves to the story-
line presented. 
 
Use MEC workcards 18-22. 
Learn how to write procedures to 
define simple shapes. 
 

 
 
 
 
 
Open Roamer World then go to File 
menu > Open > Project Launcher. 
Explanations and Teacher’s Notes for 
each project are found in Activities 
menu > Routes (or Journeys).  
[The notes assume that pupils are 
programming a floor Roamer and then 
transferring the program to computer 
with a special link, but the activities 
can successfully be used on screen.] 
 
[W] Workcards 18-22 (Sept 03) 
http://www.educationict.org.uk/ 
pdf/RoamerGrids2.pdf 

 

DEVELOPING INFORMED 
ATTITUDES  
5-14 D “Have appreciation of the less desirable 
values computers might bring to people/society” 
Show awareness of the positive and 
negative impact of computers/ICT on 
the topic areas they are covering 
 

 
As part of a topic evaluation exercise, 
pupils discuss / list / report on the role 
ICT plays. 
For example: 
Health – lack of fitness, RSI 
WWII – modern wars 
Mini-enterprise – security of 
information, employment 
PSE – personal safety, invasion of 
privacy 

 
As an ongoing thread running through 
all the topics in P7, teachers should 
pause to discuss this with pupils 
 
 

 

At the end of P7, pupils following this programme are working towards 5-14 ICT Level D in all strands except ‘Creating and Presenting – Text 
Handling and Multimedia’ and ‘Communicating and Collaborating’ (working towards Level E) 
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